Owner’s Manual
1. **Read instructions** - All the safety and operating instructions should be read before the product is operated.
2. **Retain instructions** - The safety and operating instructions should be retained for future reference.
3. **Heed Warnings** - All warnings on the product and in the operating instructions should be adhered to.
4. **Follow Instructions** - All operating and use instructions should be followed.
5. **Cleaning** - Unplug this product from the wall outlet before cleaning. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.
6. **Attachments** - Do not use attachments not recommended by the product manufacturer as they may cause hazards.
7. **Water and Moisture** - Do not use this product near water for example, near a bath tub, wash bowl, kitchen sink, or laundry tub, in a wet basement, or near a swimming pool, and the like.
8. **Accessories** - Do not place this product on an unstable cart, stand, tripod, bracket, or table. The product may fall, causing serious injury to a child or adult and serious damage to the product. Use only a cart, stand, tripod, bracket, or table recommended by the manufacturer, or sold with the product. Any mounting of the product should follow the manufacturer’s instructions, and should use a mounting accessory recommended by the manufacturer.
9. **Cart** - A product and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the product and cart combination to overturn.
10. **Ventilation** - Slots and openings in the cabinet are provided for ventilation to ensure reliable operation of the product and to protect it from overheating. These openings must not be blocked or covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is provided or the manufacturer’s instructions have been adhered to.
11. **Power Sources** - This product should be operated only from the type of power source indicated on the marking label and connected to a MAINS socket outlet with a protective earthing connection. If you are not sure of the type of power supply to your home, consult your product dealer or local power company.
12. **Power Cord Protection** - Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, paying particular attention to cords at plugs, convenience receptacles, and the point where they exit from the product.
13. **Mains Plug** - Where the mains plug or an appliance coupler is used as the main disconnect device, the disconnect device shall remain readily operable.
14. **Outdoor Antenna Grounding** - If an outside antenna or cable system is connected to the product, be sure the antenna or cable system is grounded so as to provide some protection against voltage surges and built-up static charges. Article 810 of the National Electrical Code, ANSI/NFPA 70, provides information with regard to proper grounding of the mast and supporting structure, grounding of the lead-in wire to an antenna discharge unit, size of grounding conductors, location of antenna discharge unit, connection to grounding electrodes, and requirements for the grounding electrode.

**NOTE TO CATV SYSTEM INSTALLER**

This reminder is provided to call the CATV system installer’s attention to Section 820-40 of the NEC which provides guidelines for proper grounding and, in particular, specifies that the cable ground shall be connected to the grounding system of the building, as close to the point of cable entry as practical.

15. **Lightning** - For added protection for this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power-line surges.
16. **Power Lines** - An outside antenna system should not be located in the vicinity of overhead power lines or other electric light or power circuits, or where it can fall into such power lines or circuits. When installing an outside antenna system, extreme care should be taken to keep from touching such power lines or circuits as contact with them might be fatal.
17. **Overloading** - Do not overload wall outlets, extension cords, or integral convenience receptacles as this can result in a risk of fire or electric shock.
18. **Flame Sources** - No naked flame sources, such as lighted candles, should be placed on the product.
19. **Object and Liquid Entry** - Never push objects of any kind into this product through openings as they may touch dangerous voltage points or short-out parts that could result in a fire or electric shock. Never spill liquid of any kind on the product.
20. **Headphones** - Excessive sound pressure from earphones and headphones can cause hearing loss.
21. **Damage Requiring Service** - Unplug this product from the wall outlet and refer servicing to qualified service personnel under the following conditions:
   a. When the power-supply cord or plug is damaged.
   b. If liquid has been spilled, or objects have fallen into the product.
   c. If the product has been exposed to rain or water.
   d. If the product does not operate normally by following the operating instructions. Adjust only those controls that are covered by the operating instructions as an improper adjustment of other controls may result in damage and will often require extensive work by a qualified technician to restore the product to its normal operation.
   e. If the product has been dropped or damaged in any way.
   f. When the product exhibits a distinct change in performance this indicates a need for service.
22. **Replacement Parts** - When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock, or other hazards.
23. Battery Disposal - When disposing of used batteries, please comply with governmental regulations or environmental public instructions rules that apply in your country or area.

24. Safety Check - Upon completion of any service or repairs to this product, ask the service technician to perform safety checks to determine that the product is in proper operating condition.

25. Wall or Ceiling Mounting - The product should be mounted to a wall or ceiling only as recommended by the manufacturer.

WARNING
The lightning flash with arrowhead symbol, within an equilateral triangle, is intended to alert the user to the presence of uninsulated "dangerous voltage" within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

THE EQUIPMENT MUST BE CONNECTED TO AN EARTHED MAINS SOCKET-OUTLET.

CAUTION REGARDING PLACEMENT
To maintain proper ventilation, be sure to leave a space around the unit (from the largest outer dimensions including projections) than is equal to, or greater than shown below:
- Left and Right Panels: 10 cm
- Rear Panel: 10 cm
- Top Panel: 10 cm

FCC STATEMENT
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio TV technician for help.

CAUTION
- Changes or modifications to this equipment not expressly approved by NAD Electronics for compliance could void the user's authority to operate this equipment.
- This device complies with Part 15 of the FCC Rules / Industry Canada license-exempt RSS standard(s). Operation is subject to the following two conditions:
  1. This device may not cause harmful interference, and
  2. This device must accept any interference received, including interference that may cause undesired operation.
- Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or less) gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.
- To prevent electric shock, match wide blade of plug to wide slot, fully insert.
- To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture. The apparatus shall not be exposed to dripping or splashing and no objects filled with liquids such as vases, shall be placed on apparatus.
- To satisfy FCC/IC RF exposure requirements, a separation distance of 20 cm or more should be maintained between the antenna of this device and persons during intended use. In order to disconnect the apparatus from the mains completely, the mains plug should be disconnected from the mains socket outlet completely.
- Battery shall not be exposed to excessive heat such as sunshine, fire or the like.
- Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.
- An appliance with a protective earth terminal should be connected to a mains outlet with a protective earth connection.

MPE REMINDER
To satisfy FCC/IC RF exposure requirements, a separation distance of 20 cm or more should be maintained between the antenna of this device and persons during device operation. To ensure compliance, operations at closer than this distance is not recommended.

IF IN DOUBT CONSULT A COMPETENT ELECTRICIAN.

NOTES ON ENVIRONMENTAL PROTECTION
- This product is manufactured to comply with the radio interference requirements of EEC DIRECTIVE 2004/108/EC.
- The materials can be reused in accordance with their markings. Through re-use, recycling of raw materials, or other forms of recycling of old products, you are making an important contribution to the protection of our environment.
- Your local administrative office can advise you of the responsible waste disposal point.

RECORD YOUR MODEL NUMBER (NOW, WHILE YOU CAN SEE IT)
The model and serial number of your new D 3045 are located on the back of the cabinet. For your future convenience, we suggest that you record these numbers here:

Model number: ...........................................
Serial number: ...........................................
UNPACKING AND SETUP

WHAT'S IN THE BOX

Packed with your D 3045 you will find:
• Detachable mains power cord
• AMP 3 remote control with 3V CR2025 battery
• Eight pieces of dome-shaped feet
• Quick Setup Guide

SAVE THE PACKAGING

Please save the box and all the packaging in which your D 3045 arrived. Should you move or otherwise need to transport your D 3045, this is by far the safest container in which to do so. We’ve seen too many otherwise perfect components damaged in transit for lack of a proper shipping carton, so please: Save that box!

QUICK SETUP

This simple guide will help you get started with your D 3045.

1. Place the D 3045 on a firm, level surface. Do not place the unit on a soft surface like a carpet.

2. Make all the connections to your D 3045 with the unit unplugged from the mains power source. It is also advisable to power down or unplug all associated components while making or breaking any signal or AC power connections.

   1. Connect applicable speakers to the LEFT and RIGHT SPEAKERS terminal of D 3045.
   2. Using applicable connectors (not supplied), connect source devices to corresponding input sockets of D 3045.
      - HDMI ➔ HDMI ARC
      - S/PDIF sources ➔ OPTICAL 1, OPTICAL 2, COAXIAL
      - Analog sources ➔ LINE 1, LINE 2, PHONO (MM)
      - USB sources ➔ Computer
      - Other sources ➔ Bluetooth

3. Connect corresponding end of the mains power cord to the AC mains input of the D 3045 and the plug connected to a mains power source.

4. With all applicable sources hooked up to D 3045 and powered up, press (Standby) to switch ON the D 3045 from standby mode.

5. Start listening by rotating the SOURCE knob to select preferred source input. Rotate Volume control knob to adjust audio level.

RESTORE D3045 TO FACTORY DEFAULT SETTINGS

While at operating mode, press and hold remote control’s "DIM" button until "Reset" appears in the display and Source defaults to OPTICAL 1.
1  (STANDBY)
• With the corresponding end of the mains power cord connected to the AC mains input of the D 3045 and the plug connected to a mains power source, press  (Standby) to switch ON the D 3045 from standby mode. The Standby indicator will turn from amber to bright color.
• Press and hold  (Standby) until D 3045 switches back to standby mode.

2 VOLUME
• Rotate Volume knob clockwise or counterclockwise to adjust audio level.
• Rotating the Volume knob will automatically restore audio from mute mode.

3 SOURCE
• Rotate clockwise or counterclockwise to select desired Source.

4 DISPLAY
• Sources, audio level and other indicators are shown.
• Display follows the orientation of the unit - vertical or horizontal view.

IMPORTANT NOTE
Display will temporarily turn off if there is no user interface interaction within 5 minutes. Restore display by sending a remote control command or rotating any of the controls.

5 PHONES
• Use the 3.5 mm stereo jack socket for headphone listening.
• Specially designed low noise headphone circuitry can accommodate a wide range of phones, even 600 Ohm studio models.
• Adjust headphone audio level by rotating the VOLUME control clockwise or counterclockwise.
• Ensure that the volume control is turned to minimum (fully counterclockwise) before connecting or disconnecting headphones. Listening at high levels can damage your hearing.
• Inserting a headphone jack into this socket automatically switches off the loudspeakers.

6 GROUND TERMINAL
• If a separate earth ground is necessary, use this terminal to ground your D 3045. The D 3045 can be connected to ground by connecting a ground lead wire or similar to this terminal. After insertion, tighten the terminal to secure the lead.

NOTES
• Consult with a licensed electrician to properly locate or correctly install a grounding conductor in your home. NAD is not responsible for any malfunction, damage or costs associated with the installation, connection or grounding of your D 3045.
• The grounding wire is not supplied with your D 3045.

7 PHONO (MM)
• Input for a Moving Magnet (MM) phono cartridge only. Connect the twin RCA lead from your turntable to this input if you are using a Moving Magnet cartridge.

8 LINE 1
• Connect to corresponding analog output of other audio devices using a 3.5mm stereo plug to RCA connector adapter (not supplied).

9 LINE 2
• Connect to corresponding analog output of a CD player, preamplifier, processor or other applicable devices using RCA-to-RCA stereo cable (not supplied).
10 PRE/SUB OUT
- These full range output terminals have dual function. They are used either as PRE-OUT or SUBWOOFER OUT terminals.
- The D 3045 and associated external devices must be turned OFF always before connecting or disconnecting anything to the PRE/SUB OUT sockets.

PRE OUT
- The PRE/SUB OUT sockets make it possible to use the D 3045 as a full range preamplifier to an external power amplifier.
- Use RCA-to-RCA stereo cable to connect PRE/SUB OUT to the corresponding analog audio input of compatible devices such as amplifiers, receivers or other applicable devices.
- PRE/SUB OUT will be affected by the D 3045’s volume control settings. Turn the VOLUME control to adjust the output level of the PRE/SUB OUT sockets.

SUB OUT
- Use RCA-to-RCA stereo cable to connect PRE/SUB OUT to the low level input of a powered subwoofer. Use the connected powered subwoofer controls to achieve preferred subwoofer performance.

11 OPTICAL 1-2, COAXIAL
- Connect to the corresponding optical or coaxial digital output of sources such as CD or BD/DVD players, digital cable box, digital tuners and other applicable components.

IMPORTANT NOTE
The digital audio input is 24/192 capable and can accept PCM audio signal only. Ensure that the digital audio output of your source is set to PCM before connecting to the digital audio input of D 3045.

12 COMPUTER
- Asynchronous USB 24 bit/384 kHz input assures lowest jitter for best musical performance.
- Using Type A to Type B cable connector (not supplied), interface computer audio to this asynchronous Type B USB input to directly stream 24/384 PCM content from your PC or MAC.
- When using COMPUTER as a Source, ensure that the Sound or Audio device setting of your computer is set to “D3045” or “NAD USB Audio”.

MINIMUM PC SYSTEM REQUIREMENT
Microsoft Windows 7 or higher

FOR MAC USERS
Minimum macOS Snow Leopard (version 10.6) and later versions

NOTE
Visit nadelectronics.com and download the NAD USB Audio driver from the D 3045 product page.

13 SERVICE
- Use this port only for firmware upgrade. Instructions on how to use this port for firmware upgrade is included in the D 3045 firmware upgrade (if any) procedure available from the NAD website.

14 HDMI ARC
- Connect only to TV that supports ARC (Audio Return Channel) function.
- Use HDMI cable to connect HDMI ARC to corresponding HDMI ARC port of TV.
- With ARC connection established, D 3045 will output audio signal from TV.

IMPORTANT
Ensure that the audio setting/format of ARC-connected devices to D 3045 is set to PCM only.

15 +12V TRIGGER IN
- Connect this +12V Trigger input to the remote device’s corresponding +12V DC output jack using a mono cable with 3.5mm male plug. The controlling device must be equipped with a +12V trigger output to use this feature.

16 SPEAKERS
- Connect D 3045’s Right speaker terminals marked “R +” and “R -” to the corresponding “+” and “-” terminals of your designated right speaker. Repeat the same for D 3045’s Left speaker terminals and corresponding left speaker.

17 AC MAINS INPUT
- The D 3045 comes supplied with a separate detachable mains power cord.
- Before connecting the plug to the mains power source, ensure that it is firmly connected to the D 3045’s AC Mains input socket first.
- Always disconnect the mains power plug from the mains power source first, before disconnecting the cable from the D 3045’s AC Mains input socket.
IDENTIFICATION OF CONTROLS

AMP 3 REMOTE CONTROL

1 **ON**: Power up unit from Standby mode to operating mode.
**OFF**: Switch unit to Standby mode.

2 **SOURCE ** Select through source input selections.

3 **DIM**: Toggle to select display brightness level – dim, bright or display turned off.

4 **MUTE**: Audio is temporarily switched off or restored. Restore audio by pressing MUTE again, VOL ▲/▼ or rotating VOLUME knob.

5 **VOLUME ▲/▼**: Increase or decrease loudness level.

6 **BASS**: Toggle to select BASS EQ, HP 120Hz, HP 80Hz or HP 40Hz.
   • Bass EQ boosts overall bass response by at least 6 dB.
   • HP 120Hz, HP 80Hz or HP 40Hz attenuates signal below the indicated cutoff frequency and allows higher frequencies to pass through.
   • Press and hold BASS button until BT ON (Bluetooth discoverable) or BT OFF (Bluetooth invisible) is shown in the display.

7 **BLUETOOTH CONTROLS** (applicable at BT Receive or Transmit mode)
   • Press and hold [►] button to toggle between Bluetooth RECEIVE and TRANSMIT modes.
   • Use to select through connectable Bluetooth devices at Bluetooth TRANSMIT mode.
ABOUT QUALCOMM aptX™ HD

A Bluetooth connection is a bit like a data pipeline between devices. Because the pipeline has a maximum width, it can sometimes be difficult to flow large audio files through it. aptX® reduces the size of the audio files so they can be squeezed through the wireless pipeline without affecting the sound quality.

Qualcomm® aptX™ HD audio ensures that D 3045 can deliver High Definition (HD) audio. It preserves sound data through the audio transmission, resulting in a “better-than-CD” listening experience. With aptX HD, listening to music at the highest audible quality is possible with the D 3045.

BLUETOOTH MODES

There are two Bluetooth modes – RECEIVE and TRANSMIT mode.
- **Receive:** Audio stream is received from a Source in the same Bluetooth network environment.
- **Transmit:** Audio is streamed or sent to another device in the same Bluetooth network environment.

HOW TO SELECT RECEIVE OR TRANSMIT BLUETOOTH MODE

While at BT source, press and hold [↑] until display shows RECEIVE. Press and hold [↑] again until display changes to TRANSMIT.

BLUETOOTH AT RECEIVE MODE

Initiate pairing of your Bluetooth device with D 3045 by following below procedure.
1. Using your iOS, Android or compatible device, go to Settings → Bluetooth and then scan for Bluetooth devices.
2. Select the unique device ID of your D 3045 among the available devices listed in your Bluetooth settings. Pair or connect together your D 3045 and the Bluetooth device.
3. Upon successful pairing of your Bluetooth device and D 3045, display will change to “PAIRED” and then “PLAYING” when music is played from the paired Bluetooth device.

BLUETOOTH AT TRANSMIT MODE

D 3045 is open to connect or pair with other Source devices within the same Bluetooth network environment.

1. At TRANSMIT mode, use AMP 3 [ющее] buttons to scroll through the selectable Bluetooth devices. It may take a while for selectable Bluetooth devices to manifest.
2. Press [►] to pair with selected Bluetooth device. Upon successful pairing, “Paired” is shown in the display as well as the Bluetooth device name. Press [►] again to unpair selected Bluetooth device (“Unpaired” is shown in the display).

BLUETOOTH AVAILABILITY

Bluetooth can be turned ON or OFF by the following method.
- **BT ON (discoverable):** Press and hold [BASS] button until BT ON is shown in the display.
- **BT OFF (invisible):** Press and hold [BASS] button until BT OFF is shown in the display.

FOOBAR2000 FOR MQA PLAYBACK

Foobar2000 is an advanced freeware audio player for the Windows platform and available also to macOS, iOS and Android users. Foobar2000 supports bit perfect playback required for MQA.

IMPORTANT

- The following foobar2000 download and installation process is subject to change without notice. Always download the latest freeware version.
- Below sample installation guideline is for Windows user. Foobar2000 version for Mac, Android or iOS users is also available from www.foobar2000.org/download.

INSTALLING FOOBAR2000 FOR WINDOWS PLATFORM

2. Open and run the downloaded file to install the foobar2000 audio player. Follow the command prompts to complete the installation.
3. FOOBAR2000 SETUP

   - **Welcome to the foobar2000 Setup**
   - **License Agreement**
   - **Privacy Policy**
   - **About the foobar2000 Setup**
   - **Terms of Service**
   - **Download foobar2000**
   - **Software License Agreement**
   - **Product Information**
   - **System Requirements**
   - **Upgrade foobar2000**
   - **Install foobar2000**
   - **Uninstall foobar2000**
   - **Help foobar2000**

4. FOOBAR2000 INSTALLATION

   - **Welcome to the foobar2000 Setup**
   - **License Agreement**
   - **Privacy Policy**
   - **About the foobar2000 Setup**
   - **Terms of Service**
   - **Download foobar2000**
   - **Software License Agreement**
   - **Product Information**
   - **System Requirements**
   - **Upgrade foobar2000**
   - **Install foobar2000**
   - **Uninstall foobar2000**
   - **Help foobar2000**

OTHER FEATURES

MASTER QUALITY AUTHENTICATED

Master Quality Authenticated (MQA) is a revolutionary end-to-end technology built into D 3045 that captures and delivers master quality audio. D 3045 include a powerful decoder and audio renderer for the MQA system. This ensures that MQA-encoded audio files sound exactly like the source. D 3045 accepts and playback MQA content from Computer, Optical 1, Optical 2 and Coaxial sources.

MQA INDICATORS

“MQA” or “MQA,” is shown in the display indicating that the unit is decoding and playing a MQA file.

- **MQA:** Indicates decoding and playback of a MQA file and denotes provenance to ensure that the sound is identical to that of the source material.

- **MQA:** Indicates playback of MQA Studio file that has either been approved in the studio by the artist/producer or has been verified by the copyright owner.

BLUETOOTH MODES

There are two Bluetooth modes – RECEIVE and TRANSMIT mode.
- **Receive:** Audio stream is received from a Source in the same Bluetooth network environment.
- **Transmit:** Audio is streamed or sent to another device in the same Bluetooth network environment.

HOW TO SELECT RECEIVE OR TRANSMIT BLUETOOTH MODE

While at BT source, press and hold [↑] until display shows RECEIVE. Press and hold [↑] again until display changes to TRANSMIT.

BLUETOOTH AT RECEIVE MODE

Initiate pairing of your Bluetooth device with D 3045 by following below procedure.
1. Using your iOS, Android or compatible device, go to Settings → Bluetooth and then scan for Bluetooth devices.
2. Select the unique device ID of your D 3045 among the available devices listed in your Bluetooth settings. Pair or connect together your D 3045 and the Bluetooth device.
3. Upon successful pairing of your Bluetooth device and D 3045, display will change to “PAIRED” and then “PLAYING” when music is played from the paired Bluetooth device.

BLUETOOTH AT TRANSMIT MODE

D 3045 is open to connect or pair with other Source devices within the same Bluetooth network environment.

1. At TRANSMIT mode, use AMP 3 [щение] buttons to scroll through the selectable Bluetooth devices. It may take a while for selectable Bluetooth devices to manifest.
2. Press [►] to pair with selected Bluetooth device. Upon successful pairing, “Paired” is shown in the display as well as the Bluetooth device name. Press [►] again to unpair selected Bluetooth device (“Unpaired” is shown in the display).

BLUETOOTH AVAILABILITY

Bluetooth can be turned ON or OFF by the following method.
- **BT ON (discoverable):** Press and hold [BASS] button until BT ON is shown in the display.
- **BT OFF (invisible):** Press and hold [BASS] button until BT OFF is shown in the display.

FOOBAR2000 FOR MQA PLAYBACK

Foobar2000 is an advanced freeware audio player for the Windows platform and available also to macOS, iOS and Android users. Foobar2000 supports bit perfect playback required for MQA.

IMPORTANT

- The following foobar2000 download and installation process is subject to change without notice. Always download the latest freeware version.
- Below sample installation guideline is for Windows user. Foobar2000 version for Mac, Android or iOS users is also available from www.foobar2000.org/download.

INSTALLING FOOBAR2000 FOR WINDOWS PLATFORM

2. Open and run the downloaded file to install the foobar2000 audio player. Follow the command prompts to complete the installation.
3. FOOBAR2000 SETUP

   - **Welcome to the foobar2000 Setup**
   - **License Agreement**
   - **Privacy Policy**
   - **About the foobar2000 Setup**
   - **Terms of Service**
   - **Download foobar2000**
   - **Software License Agreement**
   - **Product Information**
   - **System Requirements**
   - **Upgrade foobar2000**
   - **Install foobar2000**
   - **Uninstall foobar2000**
   - **Help foobar2000**

4. FOOBAR2000 INSTALLATION

   - **Welcome to the foobar2000 Setup**
   - **License Agreement**
   - **Privacy Policy**
   - **About the foobar2000 Setup**
   - **Terms of Service**
   - **Download foobar2000**
   - **Software License Agreement**
   - **Product Information**
   - **System Requirements**
   - **Upgrade foobar2000**
   - **Install foobar2000**
   - **Uninstall foobar2000**
   - **Help foobar2000**

Run foobar2000. Go to File ➔ Preferences ➔ Components. Confirm that “WASAPI output support” is already installed.

Go to ‘Playback’ tab. Under ‘Replay/Gain’, ensure that both “Source Mode” and “Processing” are set to “None”. Select “Apply” to confirm the setting.

Using Type A to Type B USB connector (not supplied), connect D3045 “COMPUTER” port to the corresponding USB port of your computer. Select “Output” option from “Playback” tab. Under “Device”, select “WASAPI (event): Speakers (D3045)” or “WASAPI (push): Speakers (D3045)” and then “Apply”.
15. The column header for sample-rate is not standard. Manually input sample rate as shown below.

File → Preferences → Display → Default User Interface → Playlist View → Custom Columns → Name → Sample Rate → Pattern → %samplerate% → OK

16. Activate Sample Rate in the playlist view by selecting any spot in the header and right click. Columns → Sample Rate. You may select other indicators like Bit Rate, File Size and others.

17. Select Playback device for your computer. Select “D3045” as the default speaker. Below sequence is a guideline only and may differ according to the Windows version of your computer.

Control Panel → Hardware and Sound → Sound → Manage audio devices → Playback → Speakers D3045 → Set Default

18. With D3045 as the default speaker, go to “Properties” and then “Advanced”. Ensure that both options under “Exclusive Mode” are selected.

19. Foobar2000 installation is now completed. Select foobar2000 to playback MQA files from your computer to D3045.
**AUTO STANDBY**
The D 3045 can be setup to automatically go to standby mode if there is no user interface interaction and no active Source input within 30 minutes. Auto standby mode can be enabled or disabled by the following steps.

**ENABLE AUTO STANDBY MODE**
- While at standby mode, press and hold “OFF” button of the AMP 3 remote control until the (Standby) indicator blinks once.
- At operating mode and with auto standby enabled, the D 3045 will automatically go to standby mode if there is no user interface interaction and no active Source input within 30 minutes.

**DISABLE AUTO STANDBY MODE**
- While at standby mode, press and hold “OFF” button of the AMP 3 remote control until the (Standby) indicator blinks twice.
- At operating mode and with auto standby disabled, D 3045 will not go to standby mode at any time unless directly initiated by pressing top panel’s (Standby) switch or OFF button of AMP 3 remote control.

**AUTO SENSE**
Auto sense feature enables the D 3045 to wake up from standby mode and starts operation by selecting OPTICAL 1, OPTICAL 2 or the last digital source before going to standby mode.

**CONDITIONS FOR AUTO SENSE**
- For Auto Sense to work, Auto Standby must be set to ON with D 3045 going first to standby mode.
- If IR Learning with TV remote control is successfully completed and with D 3045 going to standby mode, auto sense is activated upon detection of active digital input only from OPTICAL 1 or OPTICAL 2 inputs.
  - With this condition, D 3045 wakes up and automatically switches to OPTICAL 1 or OPTICAL 2.
- If no IR Learning is conducted, auto sense is activated upon detection of active input from the last source (limited only to the digital sources) before the D 3045 goes to standby mode.
  - With this condition, D 3045 wakes up and automatically switches to the last selected digital source prior to the D 3045 going to standby mode.

**ENABLE AUTO SENSE MODE**
- While in standby mode, press and hold “SOURCE” button of the AMP 3 remote control until the (Standby) icon on the top screen wakes up and blinks once.

**DISABLE AUTO SENSE MODE**
- While at standby mode, press and hold “SOURCE” button of the AMP 3 remote control until the (Standby) icon on the top screen wakes up and blinks twice.

**TV CONNECT**
TV Connect is a new software enabled feature that allows the D 3045 to provide the sound for your TV. TV Connect enables D 3045 to learn the mute and volume control commands from any TV remote control. Additionally, the D 3045 will automatically power up to OPTICAL source upon detection of digital TV output signal at OPTICAL 1 or OPTICAL 2 input.*

With TV Connect fully integrated, you can use your TV remote control to manage the following features of D 3045:
1. Adjust Volume up/down
2. Enable or disable MUTE function
3. Switch ON D 3045

**HOW TO CONFIGURE YOUR D 3045 WITH TV CONNECT**
TV Connect setup requires the digital optical output of your TV to be connected to the OPTICAL 1 or OPTICAL 2 input of your D 3045. With this setup and with proper configuration, when you turn ON your TV, the D 3045 powers up from standby mode and the TV input (OPTICAL 1 or OPTICAL 2) is automatically selected.* The D 3045 can also be awakened by pressing the top panel’s (Standby) and the power ON button of either AMP 3 remote control or TV’s remote control.

The following configurations are necessary to integrate TV Connect with your D 3045:
- Enable auto standby mode.
- Enable auto sense mode.
- Perform IR (infrared) learning with TV remote control.

**ENABLE AUTO STANDBY MODE**
While at standby mode, press and hold “OFF” button of the AMP 3 remote control for a few seconds until all indicators on the front screen wake up and blink once.

**ENABLE AUTO SENSE MODE**
While in standby mode, press and hold “SOURCE” button of the AMP 3 remote control until the (Standby) icon on the top screen wakes up and blinks once.
PERFORM IR LEARNING WITH TV REMOTE CONTROL
Direct or point the D 3045 or TV remote control to the D 3045 front screen when performing below procedure.

## IR LEARNING PROCEDURE

<table>
<thead>
<tr>
<th>STEP**</th>
<th>PROCEDURE</th>
<th>D 3045 FRONT SCREEN DISPLAY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press and hold [MUTE] of AMP 3 remote control to initiate IR learning mode.</td>
<td>LEARNING Choose One Key</td>
</tr>
<tr>
<td>2</td>
<td>Press [ON] of AMP 3 remote control.</td>
<td>LEARNING Power</td>
</tr>
<tr>
<td>3</td>
<td>Press [ON] of TV remote control.</td>
<td>LEARNING Press Again</td>
</tr>
<tr>
<td>4</td>
<td>Press again [ON] of TV remote control.</td>
<td>LEARNING Power OK Next Key</td>
</tr>
<tr>
<td>5</td>
<td>Repeat Steps 2 to 4 to learn “Volume +”, “Volume -” and “Mute” controls.</td>
<td>Learning “Vol +”: Press corresponding remote control button as indicated. [Vol +] of AMP 3 remote control → LEARNING Press Again → LEARNING VOL + OK Next Key</td>
</tr>
<tr>
<td></td>
<td>Learning “Vol -”: Press corresponding remote control button as indicated. [Vol -] of AMP 3 remote control → LEARNING Press Again → LEARNING VOL - OK Next Key</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Learning “MUTE”: Press corresponding remote control button as indicated. [MUTE] of AMP 3 remote control → LEARNING Press Again → LEARNING MUTE OK Next Key</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Press and hold “MUTE” to stop, complete or exit learning mode. Normal operation resumes. Any learned functions before exiting learning mode are retained and saved.</td>
<td></td>
</tr>
</tbody>
</table>

* Dependent upon the D 3045 going first to network standby mode after 30 minutes of inactivity.

** Power ON, Vol+, Vol- and Mute can be learned in any order or sequence.

## TURN OFF TV'S INTERNAL SPEAKERS (IF SO EQUIPPED)
It is recommended that you disable the TV's internal speakers so that only the D 3045 is heard. This setting is usually accessible from the TV’s Setup Menu. Consult your TV's Instruction Manual for instructions specific to your make and model of TV.

## CLEAR LEARNED IR CODES
To delete learned IR codes:
- Press and hold D 3045 remote control’s [MUTE]. When “LEARNING... Choose One Key” is shown, press and hold again [MUTE]. Learned IR codes are deleted when the display exits the learning mode screen and returns to the current source.
FEET INSTALLATION GUIDE

The dome-shaped feet are supplied for optional installation. There are two ways of installing the feet as per suggested methods below. You may generate a template for proper placement of the feet.

NOTE

Ensure that with the feet installed, the D 3045 is stable, balanced and will not tip over.
All specs are measured according to IHF 202 CEA 490-AR-2008 standard. THD is measured using AP AUX 0025 passive filter and AES 17 active filter.

### SPECIFICATIONS

#### PREAMPLIFIER SECTION

**LINE INPUT/PRE OUT**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>THD (20 Hz – 20 kHz)</td>
<td>&lt;0.003 % at 2 V out</td>
</tr>
<tr>
<td>Signal-to-Noise Ratio</td>
<td>&gt;100 dB (IHF, A-weighted, ref. 500 mV out, unity gain)</td>
</tr>
<tr>
<td>Channel separation</td>
<td>&gt;85 dB (1 kHz)</td>
</tr>
<tr>
<td>Input impedance (R and C)</td>
<td>47 kohms + 220 pF</td>
</tr>
<tr>
<td>Maximum input signal</td>
<td>&gt;5.5 Vrms (ref. 0.1 % THD)</td>
</tr>
<tr>
<td>Output impedance</td>
<td>400 ohms</td>
</tr>
<tr>
<td>Input sensitivity</td>
<td>82 mV (ref. 500 mV out, Volume maximum)</td>
</tr>
<tr>
<td>Frequency response</td>
<td>±0.2 dB (20 Hz - 20 kHz)</td>
</tr>
<tr>
<td>Maximum voltage output - IHF load</td>
<td>&gt;4 V (ref. 0.1 % THD)</td>
</tr>
</tbody>
</table>

**PHONO INPUT/PRE OUT**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>THD (20 Hz – 20 kHz)</td>
<td>&lt;0.015 % at 2V out</td>
</tr>
<tr>
<td>Signal-to-Noise Ratio</td>
<td>&gt;83 dB (200 ohms source, A-weighted, ref. 500 mV out)</td>
</tr>
<tr>
<td></td>
<td>&gt;76 dB (MM cartridge source, IHF; A-weighted, ref. 500 mV out)</td>
</tr>
<tr>
<td>Input sensitivity</td>
<td>1.15 mV (ref. 500 mV out, Volume maximum)</td>
</tr>
<tr>
<td>Input overload</td>
<td>10mV/100mV/300mV (20Hz/1kHz/20kHz)</td>
</tr>
<tr>
<td>Maximum input signal at 1kHz</td>
<td>&gt;90 mVrms (ref. 0.1 % THD)</td>
</tr>
<tr>
<td>Frequency response</td>
<td>±0.3 dB (20 Hz - 20 kHz)</td>
</tr>
<tr>
<td>Input overload</td>
<td>10mV/100mV/300mV (20Hz/1kHz/20kHz)</td>
</tr>
<tr>
<td>Maximum input signal at 1kHz</td>
<td>&gt;90 mVrms (ref. 0.1 % THD)</td>
</tr>
<tr>
<td>Frequency response</td>
<td>±0.3 dB (20 Hz - 20 kHz)</td>
</tr>
</tbody>
</table>

Note: The RIAA response is consistent with a pre-emphasis that is rolled off at 50kHz by a second order filter, such as used in Neumann cutting lathes.

**LINE INPUT/HEADPHONE OUT**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>THD (20 Hz – 20 kHz)</td>
<td>&lt;0.003 % at 120mV</td>
</tr>
<tr>
<td>Signal-to-Noise Ratio</td>
<td>&gt;90 dB (32 ohms load; A-weighted, ref. 500mV out, unity gain)</td>
</tr>
<tr>
<td>Frequency response</td>
<td>±0.3 dB (20 Hz - 20 kHz)</td>
</tr>
<tr>
<td>Output impedance</td>
<td>2 ohms</td>
</tr>
<tr>
<td>Maximum headphone output – 32 ohms load</td>
<td>&gt;8 V (ref. 0.1% THD)</td>
</tr>
</tbody>
</table>

### GENERAL SPECIFICATIONS

**LINE INPUT/SPEAKER OUT**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous output power into 4 and 8 ohms</td>
<td>60 W (ref. 20 Hz-20 kHz at 0.03% THD, both channels driven)</td>
</tr>
<tr>
<td>THD (20 Hz – 20 kHz)</td>
<td>&lt;0.005 % (at 1W, 4 and 8 ohms)</td>
</tr>
<tr>
<td>Signal-to-Noise Ratio</td>
<td>&gt;98 dB (A-weighted, 500 mV input, ref. 2.828 V out in 4 ohms)</td>
</tr>
<tr>
<td>Clipping power</td>
<td>&gt;80 W (at 1 kHz 4 ohms 0.1 % THD)</td>
</tr>
<tr>
<td>IHF dynamic power</td>
<td>8 ohms: 80 W</td>
</tr>
<tr>
<td></td>
<td>4 ohms: 150 W</td>
</tr>
<tr>
<td></td>
<td>2 ohms: 200 W</td>
</tr>
<tr>
<td>Peak output current</td>
<td>&gt;18 A (in 1 ohm, 1 ms)</td>
</tr>
<tr>
<td>Damping factor</td>
<td>&gt;100 (ref. 8 ohms, 20Hz to 6.5kHz)</td>
</tr>
<tr>
<td>Frequency response</td>
<td>±0.3 dB (20 Hz - 20 kHz)</td>
</tr>
<tr>
<td>Channel separation</td>
<td>&gt;75 dB (1 kHz)</td>
</tr>
<tr>
<td></td>
<td>&gt;70 dB (10 kHz)</td>
</tr>
<tr>
<td>Input sensitivity</td>
<td>260 mV (for 60 W in 4 ohms)</td>
</tr>
<tr>
<td>Supports bit rate/sample rate</td>
<td>up to 24 bit/192 kHz (digital sources)</td>
</tr>
<tr>
<td></td>
<td>up to 24 bit/384 kHz (computer source)</td>
</tr>
<tr>
<td>Standby power</td>
<td>&lt;0.5 W</td>
</tr>
</tbody>
</table>

### DIMENSION AND WEIGHT

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross dimensions W x H x D</td>
<td>70 x 235 x 265 mm</td>
</tr>
<tr>
<td>Net weight</td>
<td>3.6 kg (7.9 lbs)</td>
</tr>
<tr>
<td>Shipping weight</td>
<td>2.6 kg (5.7 lbs)</td>
</tr>
</tbody>
</table>

* - Gross dimension includes volume knob and extended rear panel terminals.

Qualcomm aptX is a product of Qualcomm Technologies International Ltd.

MQA* is a trade mark of MQA Limited.

NAD shall not be held liable for any technical or user interface discrepancies in this manual. The D 3045 owner’s manual may be subject to change without notice. Check out www.nadelectronics.com for the latest version of the D 3045 owner’s manual.